=Roland Workshop

- Expandable Synthesizer Module
SOHICCEI and Audio Interface

Using SonicCell with SONAR LE"

© 2008 Roland Corporation U.S.
All rights reserved. No part of this publication may be reproduced in any form without the
written permission of Roland Corporation U.S.
SONAR LE™is a trademark of Twelve Tone Systems, Inc.
Twelve Tone Systems, Inc. is not associated or affiliated with Roland in any manner.

SCWS03

Download from Www.Somanuals.com. All Manuals Search And Download.



About the Workshop Booklets

Roland’s SonicCell is designed for modern musicians. Using USB, It adds a
huge set of sounds to your digital audio workstation (or “DAW”") without
adding to your computer’s workload. It’s also an audio interface that can get
signals from mics, instruments, or other devices to DAW tracks for recording.
SonicCell’s Editor software allows you to program SonicCell from within your
DAW. Onstage, its compact size also makes SonicCell the ideal companion
for a laptop DAW, letting you perform and sing along with recorded tracks.
Or use it to play back sequences and audio files from a USB memory stick.

Each SonicCell Workshop booklet focuses on one SonicCell topic, and is
intended as a companion to the SonicCell Owner’s Manual. This booklet
requires SonicCell O.S. Version 1.11 or higher. You can download the latest
SonicCell O.S. for free from www.RolandUS.com.

About This Booklet

This booklet contains instructions for using SonicCell with Cakewalk’s
SONAR LE 5.2, which is included in the SonicCell box. First we'll discuss
recording MIDI tracks in SONAR LE using SonicCell’s synth sounds. Next, we’'ll
talk about SonicCell as as an audio interface, telling you how to record both
live audio and SonicCell’s synth sounds as audio tracks in SONAR LE.

We'llassumeyou'veinstalledand knowhow to operate SONARLE—otherwise,
consult SONAR LE’s built-in documentation in its Help menu. We'll also
assume you've read the Using SonicCell with a DAW and Using SonicCell as an
Audio Interface Workshop booklets, that both SonicCell and your computer
are hooked up and turned on, and that you're listening through SonicCell.

Understanding the Symbols in This Booklet

Throughout this booklet, you'll come across information that deserves
special attention—that’s the reason it's labeled with one of the following
symbols.

)) A note is something that adds information about the topic at hand.
1{ A tip offers suggestions for using the feature being discussed.

,>'< Warnings contain important information that can help you avoid
’*""( possible damage to your equipment, your data, or yourself.

Configuring SONAR LE to Work With SonicCell

You've got three things to prepare in SONAR LE for using it with SonicCell:
SONAR LE’s audio system, the SonicCell Editor, and SONAR LE’s MIDI system.
The following sections walk you through these three operations.

Setting Up SONAR LE for SonicCell Audio

/ When you first launch SONAR LE, you’ll encounter warnings about not
)) having any MIDI outputs and inputs selected. Click Continue with No
MIDI Output and then Continue with No MIDI Input for now.

Here's how to set up SONAR LE so you can hear what you're doing through
SonicCell. We'll also prepare SONAR LE to record SonicCell’s synth sounds
and any live audio you're sending through it: 5

1 After launching SONAR LE, select Audio... from
the Options menu to open the Audio Options

project...

window, and then click the Advanced tab. b

Colors...

2 Set Driver Mode to ASIO, and click OK, as shown B
in the screenshot on the next page. ielzton ..

Mon-Destructive MIDL Editing

Time Ruler Format »

Drum Map Manager...

Contral Surfaces...
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Rutio Options - 510 & If you select a sampling rate other than the one SonicCell is using,
oz 22 i e you'll see a message telling you that’s not possible, and that SONAR
, , . ,
[lEvobioBesdCoching [JEroboins Cacking LE's sample rate’s been reset to match SonicCell’s.

140 Buffer Siea (B} 128 |2
Plogback and Recording

Diiver Mode: O Tringer & Fresuheel

[Best when sound card has &

P e e

‘2 “The default audio Format is not compatible with ane or more sound cards. It has been reset to 44100 Hz (32 bit), a5 suggested by the driver.

Shere Divers With Other Programs @ Full Chase Lock e
EL Tres [Best when chasing to MIDI
[ Use Muliprocessing Engine \ime cods)

Tt e
To use another sampling rate, change SonicCell’s sample rate first as

described in the Using the SonicCell with a DAW Workshop booklet.

)? If you want to work on a project in which audio’s already been
recorded, first set SonicCell’s sample rate to match the project’s.

Windows asks you to relaunch SONAR LE for your new settings to
take effect.

7 Click the Drivers tab, and select 1: Roland SonicCell IN L and 1: Roland
\j{) ;:a'ﬁﬁ;;w’\!;’n;n:zk:;:ectunu\thar\extt\maynustartthepmgvam. To mak them take effect now, please choose Exit from the File menu, then SOhiCCe” OUT L as input and Output driVerS, I’espective|y, |f theylre

Click OK, quit SONAR LE, and then relaunch the program.

After SONAR LE has restarted, close the Quick Start window and
return to Audio... in the Options menu.

In the Audio Options General tab, set Playback Timing Master to 1:
ROLAND SonicCell:OUT 1—Record Timing Master is automatically set
to the same thing, as shown here.

Audio Options - ASIO 3]
I —— Y I3
< Playback Tining Mster [ BuTL
Budio Diver B Deplh

StereoPaningLaw: |48 center, sinzos taper, constant power |
Sampling Rale: FieBiDepthy 16 v
Bulfors in Playhack Queus: |2 |-

BuferSze | dmes

Fast
Effective latency at 44kHz/steres 929 mseo

4510 Parel..

Set Sampling Rate to SonicCell’s sampling rate.

not already selected.

Audio Options - ASID 3]
| General | Advanced | Diivers | 0K
Click on a diver to snabls or disable it
| inputDiivers |
T

Click OK to exit the Audio Options window.

When you close the Audio Options window, Windows once again
tells you that you'll need to relaunch SONAR LE.

Quit and then relaunch SONAR LE.
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Setting Up SONAR LE to Use the SonicCell Editor

’

When you install the SONAR LE that came with SonicCell, the VST
Adaptor application is installed on your hard drive.

Use Cakewalk’s VST Adaptor application to register the SonicCell Editor
as a plug-in for SONAR LE. With the version of SONAR LE that ships with
SonicCell, you'll need to update SONAR LE’s VST Adaptor application. You'll
find this program on the CD-ROM that came with SonicCell.

To update the VST Adaptor:

1
2
3

Insert the SonicCell Editor CD, and open its Sonar Utility folder.
Open the VST Adapter folder.

Double-click VSTAdapter453Update_E file to launch the VST Adaptor
updater.

In the Select Language window, select U.S. English, and click OK.

In the Welcome! window, click Next—the update is applied, and the
Wrap VST Plugins window appears.

Click Cancel—the Install window appears warning you that setup is
not complete, but it is for us, so click Exit Setup.

Once you've updated the application:

1

From the Start menu, select All Programs > Cakewalk > Cakewalk VST
Adapter > Cakewalk VST Adapter 4.

When the Cakewalk VST Configuration Wizard: Welcome window
opens, click Next.

In the Cakewalk VST Configuration Wizard: Search Paths window,
click Add...

Navigate to your C drive, the Program Files folder—presuming you
used the default install location—highlight the Roland folder, and
click OK.

Back in the Cakewalk VST Configuration Wizard: Search Paths window,
click Next—SonicCell Editor VST appears in the resulting Cakewalk
VST Configuration Wizard: Plugin Configuration window.

Click Next to finish registering the SonicCell Editor.

Setting Up SONAR LE for SonicCell MIDI

In the following sections, we'll assume a couple of things about the way
you're working. We'll assume

Here's how to get SONAR LE to exchange MIDI data
with SonicCell:

1

In SONAR LE, select MIDI Devices... from the
Options menu to open the MIDI Devices
window.

In the Inputs and in the Outputs panes, select
1:Roland SonicCell so it's highlighted:

MIDI Devices

Click OK.

you've got SonicCell in Performance mode—using SonicCell’s PRST 01
Seq: Template performance to start with.

you've connected a MIDI controller to SonicCell's MIDI IN jack—and that
you've turned on SonicCell’s USB-MIDI Thru parameter, as described in
the Using SonicCell with a DAW Workshop booklet.

Instruments... %

Audio, ..
Audio Meter Settings...

Project...
Global, .,
Colats...

Key Bindings...

Initilization File...
Mon-Destructive MIDI Edting

Time Ruler Format 4
Drum Map Mariager ..

Control Surfaces. .

From the Options menu, select Global... to open the Global Options

window.

Make sure that Always Echo Current MIDI Track is checkmarked so
that your SonicCell patch plays as you sequence, and click OK.

SONAR LE is now set up to exchange MIDI data with SonicCell.
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Creating a SonicCell Editor Track , . . _
/ Changes you make to SonicCell using the Editor affect SonicCell’s

s current performance, or—if you’re in Patch mode—its current patch.
You'll need to do this first so you have an easy way to

select patches for your SonicCell synth tracks. . . . o .
5 To close the Editor window at any time, click its Minimize button—it

1 Select an unused audio track in your project, then appears as a small launcher above the Task bar. To re-open it,
or insert a new one. e consde A click the launcher’s Restore Up button.

2 Click the track’s Restore Strip Size button to Insert MIDI Track @

display its settings. Once you’ve set up the editor, you can click its SONAR LE track’s

Minimize Strip button to shrink the track vertically.

We recommend renaming the track “Editor” to make it easy to locate

f
¥ as your arrangement grows in complexity.

Using the SonicCell Editor

Part-selection area Patch-selection area

B3 2.ST SonicCollEditor VST [1Nack 1] - SonicColl Sotup : Untitod

/ If the new track doesn’t look like the one here, click the All tab at the
bottom of the tracks area to reveal all of the track’s settings.

3 Right-click in the track’s FX area and
select VST SonicCell Editor from the
DXi Synth popup menu.

Bypass Bin

Audio Effects ¥

4 The SonicCell Editor launches e Comnections Rt 56

Cakewalk TT5-1
and retrieves SonicCell’s current e o
Pentagon 1

performance’s settings. et

Reland Groovesynth

RxP

Mode-selection buttons

You'll find detailed instructions for using the SonicCell Editor in its manual,
which you can display by clicking the Help button in the SonicCell Editor
window. What follows here are some quick instructions to get you started.
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Everything you set up in the SonicCell Editor is automatically saved Before using the PERFORM PATCH buttons, be sure to select the part

)? in your SONAR LE project. When you reload the project, the Editor )) that plays the patch you want to edit. You do this by clicking the part’s
automatically sets up the current performance in SonicCell to match. number in the part-selection area at the top of the window.
Selecting a Patch for a Part Sequencing with SonicCell Patches
You choose each patch you want to use in SONAR LE by selecting it for the 1 Open the project you want to work on, or create a new one.

part that a SONAR LE MIDI track is configured to play. Here’s how: In SONAR LE, you can identify MIDI tracks by the MIDI jack ‘

1 Click the desired part’s number in the PARTS area of the Editor icon to the left of a track’s name.
window. . .
2 If no unused MIDI tracks are available in the
2 Select a patch for the part using the controls in the patch-selection project, right-click below the project’s tracks,
area, circled in red on the previous page. To select a patch by: and select Insert MIDI Track from the popup.
memory location—click the PATCH NAME parameter’s popup 3 Click the track you want to use, and click its I console A3
arrow to reveal SonicCell’s patches organized by their memory Restore Strip Size button to reveal its settings. M
|ocat|ons' Insert MIDI Track.

category—click the CATEGORY parameter’s popup arrow to
reveal SonicCell’s patches divided into categories.

;f You can select performances stored in SonicCell using the PERFORM
NAME popup located above the part-selection area.

Digging Deeper 4 Click the track’s Input popup arrow and select 1:Roland SonicCell -

. . . Ch. 1 from the popup menu.
The SonicCell Editor lets you change the current performance’s sounds in a

range of ways. The mode-selection buttons to the left of the Editor window 5  Click the track’s Output popup arrow and select 1-1:Roland SonicCell

determine the parameters you see and can edit at any given time. They’re from the popup menu.

divided into the following sections: 6  Set the Channel parameter to the number of the SonicCell part
SYSTEM—The buttons in this area allow you to set SonicCell’s global whose patch you want to sequence.

behavior, and also get quick access to its input effect, a handy thing

when you're recording live audio through SonicCell.
We've selected

PERFORM EFFECTS—These buttons edit the performance’s effect setup. MIDI Channel 1
PERFORM—These parameters allow you to control the way each part to play‘the patch

. belonging to
plays its patch, and lets you add effects to the patch. Part 1

PERFORM PATCH—These parameters allow you to dig right inside a
part’s patch in order to edit it down to its most basic characteristics.
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If you haven’t yet selected a patch on SonicCell to play from this track,
open the SonicCell Editor and assign the desired patch to the part you
want to use. Once you’ve done that, return to the MIDI track you’ve
been setting up.

When you play your controller with your new track selected, you
should hear the desired patch play in SonicCell.

Record your SonicCell track as you would any other SONAR LE track—
when you play it back, you'll hear its SonicCell patch play. (You can
shrink the track vertically by clicking its Minimize Track button once
you're done with it.)

Repeat Steps 2-8 for other SonicCell tracks you want to sequence.

At this point, your track is sequenced, and you’ll hear it each time you
play your project, including when you edit the track. However, the
sound is still coming from SonicCell itself—it hasn’t yet been recorded
as an audio track in SONAR LE. We’ll get to that in the next section.

Recording Audio from SonicCell in SONAR LE

#

If you haven’t yet read the Using SonicCell as an Audio Interface
Workshop booklet, read it now before proceeding. SonicCell offers lots
of audio-interface options you’ll want to know about.

Setting Up an Audio Track for Recording

Selecting Audio to Record

1

Open the project you want to work on, or create a new one.

. You can spot audio tracks by the waveform icon to the left
of a track’s name.

If no unused audio tracks are available in the
project, right-click below the project’s tracks,
and select Insert Audio Track from the popup.

Click the audio track to select it, and then its HI console A3

the Restore Strip Size button to reveal the m
Insert MIDI Track.

track’s settings.

Click the track’s Input popup arrow and select the SonicCell output
from which you want to record. To record

° a mic or instrument connected to SonicCell’s Neutrik input jack—
select Left Roland SonicCell IN L.

Right Roland 5or
Sterec Roland ScricCell IN L

e astereo device connected to SonicCell’s Neutrik and (LINE) R input
jacks—select Stereo Roland SonicCell IN L.

e aSonicCell synth patch in stereo—select Stereo Roland SonicCell
IN L.

Make sure the track’s Output is set to Roland SonicCell OUT L. When
you're done, the track’s settings should look like this:
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Turn Off Software Monitoring

1

If the track’s channel strip isn't visible, click the track in the Track

window. .

Click the channel’s Input Echo button so  § ][R [+

its not it S

As we noted in the Using the SonicCell with a DAW Workshop booklet,
you do have the option of listening through SONAR LE if you want to
hear its effects as you record. However, unless you need to hear one
of the SONAR LE’s effects while recording, we recommend listening
through SonicCell since you may encounter latency listening directly
through SONAR LE.

Record your track as you would any SONAR LE audio track. (As with
a MIDI track, when you're ready to move to another track, you can
reduce the size of the track by clicking its Minimize Track button.)

Repeat the steps in these last two sections for any other audio tracks
you want to record.

Before Recording: SonicCell Audio-Recording Strategy

Since SonicCell can simultaneously be the source of synth sounds and your
live audio, a little thought needs to be given to making sure you're only
recording exactly what you intend to record on any given track.

When you want, for example, to record a single SonicCell synth sound on
its own track, you don't want your other synth sounds to also find their way
onto that track. Likewise, when you want to record a vocal or other live audio
signal, you don’t want to wind up with your synth tracks recorded on that
live audio track.

Here’s what you have to do.

When you want to record a single synth track as a SONAR LE audio track

mute any other SonicCell synth tracks you have in the song by
clicking their Mute buttons to light them, or mute their parts in
the SonicCell Editor.

If you've connected a mic, instrument, or other device to one of
SonicCell’s inputs, disconnect it until you're ready to record its
audio onto a SONAR LE track.

When you want to record live audio as a SONAR LE audio track, you can use
either of two methods:

Ifyou need to hear your SonicCell synth tracks as you record—send
your live audio through SonicCell’s input effect, and then set the
TO COM parameter on the In/Out Routing screen to Input FX.

If you don't need to hear SonicCell synth tracks as you record—
mute them in SONAR LE by clicking their Mute buttons to light
them, or mute their parts in the SonicCell Editor.

The End

We hope you've found this workshop helpful. Keep an eye out for other
SonicCell Workshop booklets available for downloading at www.RolandUS.
com.
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